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1 Introduction

1 Introduction

The Portable VA Analyzer software is an easy-to-use computer soft-
ware to control @ modern hand-held voltammetry stand for trace analysis
of metals and other electronchemically active substances, the 946 Portable
Analyzer.

The software controls the measurements, records the measured data and
evaluates it, thus ensuring a straightforward measuring process. Built on
Windows operating principles, intuitive handling is guaranteed. Fixed
method structures in the Portable VA Analyzer software make your deter-
minations easy and quick. This comes in handy especially when dealing
with routine applications.



2 Overview of the software

1

3

Portable VA Analyzer software provides the control of all instrument
functions. An intuitive interface helps the user to control the following
meausing modes:

= Square wave (see Chapter 11.3, page 62)
» Linear sweep (see Chapter 11.1, page 57)
= Differntial pulse (see Chapter 11.2, page 59)

H NOTE

More details about the hardware can be found in the 946 Portable VA
Analyzer manual (8.946.8001EN).
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Figure 1 Portable VA Analyzer software - overview (default workplace
layout)
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4 Messages subwindow




2 Overview of the software

5 Status bar 6 Live curve
7  Graphics subwindow 8 Results subwindow

9 Curves subwindow

Menu bar (1-1)

File Load and save a method.
Load and save a determination.

Reprocess the curve evaluation.

Devices Connect / disconnect the potentiostat.
Start / Hold / Stop the determination.

View Selections regarding the general appearance of the curves subwindows, such as
scaling, labels, and background color.

Selection of the workplace layout.

Curves Selections regarding appearance of curves, such as name, visibility, and color.

Export functions for determination curves.

Method Open the dialog window to edit method or determination parameters.
Reports Create PDF report

Language Select the software language English or Chinese

Help Information regarding the device.

Information regarding the software version.

Link to the PDF file of the manual.

Toolbar (1-2)
=) New method Load and open a method with default square-wave parameters.
W Load determination Opens the dialog window to load an existing determination file.

By default, determinations are saved in the folder %USERPROFILE%\Docu-
ments\Metrohm\Portable VA Analyzer\Determination.

Example determinations can be found in the folder %USERPROFILE%\Docu-
ments\Metrohm\Portable VA Analyzer\Examples\Determinations.

)

Load method Opens the dialog window to load an existing method file.
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By default, methods are saved in the folder %USERPROFILE%\Documents
\Metrohm\Portable VA Analyzer\Method.

Example methods can be found in the folder %USERPROFILE%\Documents
\Metrohm\Portable VA Analyzer\Examples\Methods.

Establish a connection between the software and the instrument by means of a
USB cable (see Chapter 3, page 7).

Inactive when an instrument is connected.

Disconnect the software from the instrument.

Inactive when no instrument is connected.

Start the determination.

Inactive when no instrument is connected.

Hold the determination. Click the button again to continue.

Inactive when no instrument is connected.

Stop the determination.

Inactive when no instrument is connected.

Change the view of the workplace to default.
This layout shows Live curve and Curves in separate subwindows.

= The Live curve subwindow is only displayed when an instrument is connec-
ted.
= The Curves subwindow can have up to 5 tabs.
— The tab Curves shows an overlay of voltammograms belonging to
the determination.
— The tab(s) ‘'Substance name' calibration show the calibration curve
for a substance. Each calibration curve is displayed on an individual
tab.

Change the view of the workplace to tabs.
This layout has only one subwindow Curves with a maximum of 6 tabs.

= The tab Live curve is only displayed when an instrument is connected.

= The tab Curves shows an overlay of voltammograms belonging to the deter-
mination.

= The tab(s) 'Substance name' calibration show the calibration curve for a
substance. Each calibration curve is displayed on an individual tab.

Change the view of the workplace to a mosaic.
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2 Overview of the software

This layout shows all curves in individual subwindows. The actual layout
depends on the number of calibration curves displayed.

= The Live curve subwindow is only displayed when an instrument is connec-
ted.

= The Curves subwindow shows an overlay of voltammograms belonging to
the determination.

= The calibration curve of each substance defined in the method is shown in
an individual subwindow with the name 'Substance name' calibration.

Open the dialog window to edit method or determination parameters. The
parameters can be found on four tabs:

= General
General settings for the determination, such as information on sample identi-
fier, user name and sensor as well as selection of documentation.

= Determination
Settings related to the execution of the determination, such as sample and
total volume, stirring rate and time, blank value correction and number of
replications and additions.

= Voltammetric
Settings related to the voltammetric measurement. Exact parameters depend
on the chosen measuring mode. Available measuring modes: Square wave,
Linear sweep and Differential pulse.

= Evaluation
Settings related to data processing, peak recognition and calibration.

Reprocess the curve evaluation after deactivating individual curves or editing
base points in the Results subwindow. Details on the reevaluation of peaks can
be found in Chapter 4.4 Reevaluating a determination (page 31).

Open the dialog window to select the report elements which should be printed
in a PDF report.

Run subwindow

Messages sub-
window

Status bar

(1-3)

Display of the general method sequence and the progress of the determi-
nation

(1-4)

Display of messages which stop the process of the determination and
require actions by the operator, e.g. addition of standard solution.

(1-5)
Display of the potentiostat status.

Connected  |19460010 Running  |Node 1  |Measuring |Time: 3.1 5, Potential: 0.110 V, Current: 0.128 uA

1 2 3 4 S



Live curve

Graphics subwindow

Results subwindow

Curves subwindow

1. Connection status: Connected / Disconnected
2. Instrument type (only displayed when connected): 19460010
3. Potentiostat status (only displayed when connected): Stopped / Run-

ning

4. Status of the voltammetric measurement: Potential / Equilibration /
Measuring

5. Display of time, potential and current related to the voltammetric
measurement.

(1-6)

Live display of the currently measured voltammogram.

Subwindow in the Default workplace and Mosaic workplace layout.
In the Tabs workplace layout, it is found in the Curves subwindow as
separate tab.

(1-7)

Display of color and name of the curves belonging to the currently run-
ning or loaded determination. In this subwindow, the curves have to be
selected for which name, color or visibility should be changed. Also for
individual export the curves have to be selected in this subwindow.

(1-8)

This subwindow includes 2 to 5 tabs. The tab Results shows the overview
of the results calculated for all substances specified in the method. Evalua-
tion details, like peak potentials and peak heights can be found on up to 4
additional tabs. One tab for each substance, tagged with ‘Substance
name"'.

(1-9)

This subwindow includes maximum 6 tabs. The tab Curves shows all vol-
tammograms belonging to the determination. Calibration curves for each
substance can be found on up to 4 additional tabs. One tab for each sub-
stance, tagged with 'Substance name' calibration. In the Tabs work-
place layout, one additional tab Live curve is displayed in this sub-
window.



3 Connecting the software with the instrument

3 Connecting the software with the instrument

Prerequisites

= The potentiostat is connected to the measuring stand.

1 = Connect the USB type B mini connector of the cable
(6.02108.000) to the connection socket USB on the rear of the
potentiostat.

= Connect the USB type A connector of the USB cable to the PC or
laptop.

2 Start the Portable VA Analyzer software by double-clicking the desk-

)
top icon wsskwanye Or selecting the link Portable VA Analyzer
under Windows start menu > All programs » Metrohm > Port-

able VA Analyzer

3 Switch on the instrument. Press the ON/OFF button on the rear of
the potentiostat.

The green status LED on the front of the potentiostat indicates when
the power is on.

4 |n the Portable VA Analyzer software click on & or Menu
bar » Devices » Connect.

When the instrument is correctly connected and ready to use:

= the status bar shows Connected and the instrument type
19460010.
= An additional subwindow Live curve appears.

= The & button is available for disconnecting the instrument.

Connecting the instrument manually

Prerequisites

= The potentiostat is connected to the measuring stand.
= The potentiostat is connected to the computer.
= The potentiostat is switched on.

1 In the menu bar click on Devices » Manual connect...



2 = Choose the COM port where the instrument is connected.
= Click on [Connect]

E NOTE

The correct COM port can be found in the Windows Device Man-
ager. More information on how to open the Device Manager can
be found in Chapter 3 of the Installation manual of the Portable
VA Analyzer Software (8.946.8002EN).

Connecting the instrument after a connection error

Prerequisites

= The potentiostat is connected to the measuring stand.
» The potentiostat is connected to the computer.
» The potentiostat is switched on.

-
|}

Click on & to properly disconnect the instrument.
= Restart the software.

2 = Switch off the instrument.
= \Wait 3 seconds.
= Switch the instrument back on.

3 Click on @ or Menu bar » Devices » Connect.



4 Software operation

4 Software operation

4.1 Creating a new method
Dialog window: Menu bar » File » New Method

1 « Inthe toolbar, click on & or
= in the menu bar click on File » New Method

The Method parameters dialog window opens.

2 = Enter or change the method parameters.
= Click on [OK]

If all method parameters are correct, the parameters are saved and
the dialog window is closed.

If the method parameters contain errors, the dialog window cannot
be closed. An [Errors] button is activated.

3 Click on [Errors].

An Errors dialog window is opened.

4 Correct the errors listed in the Errors dialog window, and click on
[OK].

If all method parameters are correct, the parameters are saved and
the dialog window is closed.



4.1 Creating a new method

General

Determination

Voltammetric

Evaluation

OK

10

Method parameters dialog window

J{Generai | Determination | voltammenic | Evaiuaton |

Information

Sample idonsfier -

Usef name

Sensor

Instrumant

Determination starl -

Mathod

Remarks

Documentation

Repoit O

Repor elements.

|Lo | | cancet |

Figure 2 «General» tab of «Method parameters» dialog window

In the Method parametes window, the parameters for the method are
defined.

Contains information fields and selections to define the automatic PDF
printout at the end of the determination. For details see Chapter 4.1.1,

page 11.

Contains specifications regarding the general sequence of the determina-
tion. The parameters displayed depend on the selected calibration techni-
que and measurement technique. For details see Chapter 4.1.2, page

13.

Contains parameters for preparation procedures and measuring mode.
The parameters displayed for the sweep depend on the measuring mode
selected. For details see Chapter 4.1.3, page 15.

Contains parameters for data processing, peak evaluation, and concentra-
tion calculation. For details see Chapter 4.1.4, page 21

Closes the dialog window.

The method parameters are validated for wrong values or values out of
the specified limits. If the method parameters contains errors, the dialog
window cannot be closed.



4 Software operation

Cancel
Closes the dialog window. All changes to the parameters are lost.
Errors
Opens an Errors dialog window which lists all the errors in the method
parameters.
4.1.1 Method parameters — General
Tab: Menu bar » File » New Method > General
Information

Identification for samples.

This name is inserted in the Sample field of all reports and results win-
dows. The Sample identifier is also used as part of the file name.

Sample identifier

Entry 34 characters

User name
Name of the User. This name is inserted in the User field of all reports and
results windows.

Sensor
Name for the sensor used. This name is inserted in the Sensor field of all
reports and results windows.

Instrument

Name of the instrument.

Non-editable. Data automatically filled in from determination data.

Determination start
Date and time of determination start.

Non-editable. Data automatically filled in from determination data.

Method
Name of the method used.

Non-editable. Data automatically filled in from determination data.

Remarks

Remark regarding the method. This remark is inserted in the Report field
of all reports and results windows.

Documentation

11
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4.1 Creating a new method

Report
on | off (Default value: off)
Activate this check box to enable automatic printout and storage of a PDF
report at the end of the determination.

Report elements
Sections of report contents can be selected.

Results
on | off (Default value: on)
Activate this check box to print the follwing information:
» General and determination information.

= Table with concentration result for all substances in the determination.

Evaluation
on | off (Default value: on)

Activate this check box to print the follwing information:

= Table with evaluation details, like peak potential and peak height, for
each substance and curve.
= Table with regression data for each substance.

Curves
on | off (Default value: on)
Activate this check box to print the follwing information:
= Overlay of all voltammograms which are visible.

= |ndividual calibration curve for each substance.

Method
on | off (Default value: on)

Activate this check box to print the method parameters.

Procedure
on | off (Default value: on)

Activate this check box to print the method sequence.



4.1.2

Sample and volume

Run

4 Software operation

Method parameters — Determination

Tab: Menu bar > File » New Method » Determination

The Determination tab of the Method parameters dialog window
contains specifications regarding the general sequence of the determina-
tion. The parameters displayed depend on the selected calibration techni-
que and measurement technique.

[ coners [ omermnaton | votammens | Evmanon |
$ample and volume
Totsl coll volum (=L} 8
Run
Sang e (s} 0
S L 1 om0 0 2
M ofewacascns ]
W ol asdmens x|
LE"‘ Comcet | Emon}
Figure 3 «Determination» tab of «Method parameters» dialog window

Sample volume (mL)

Volume of sample to be added in the measuring vessel. The volume is
used for the calculation of the final result.

0.000001 - 9999999 mL
15 mL

Input range
Default value

Total cell volume (mL)

Stirring time (s)

Total volume of solutions (sample + auxiliary solution, e.g. buffer, addi-
tional water) in the measuring vessel prior to the first standard addition.

Input range 0.000001 - 9999999 mL
Default value 18 mL
The Total cell volume must be 2 Sample volume.

Time for stirring the measuring solution. Stirring is carried out:

= At the beginning of the determination.
= After the addition of sample (only if Blank is active).
= After each addition of standard solution.

0-9999 s
10 s

Input range
Default value

13



4.1 Creating a new method

14

Stirring rate (1/min)

Measure blank

Rotations per minute of the stirrer. The stirrer is active during the stirring
time and remains active during all preparation procedure steps (Cyclovol-
tammetric pretreatment and Potentiostatic pretreatment) until the
start of the measuring sweep.

Input range 500 - 4000 1/min
Default value 2000 1/min

on | off (Default value: off)

Measure a blank solution before sample determination. This background
compensation is mainly used to reduce interference due to the supporting
electrolyte. Such interference includes both the presence of the analyte
(blank value) and that of foreign substances electroactive in the same
range.

Activating the check box Measure blank, enables the following parame-
ters:

No. of blanks

Number of measurements to determine the blank curve. If the blank solu-
tion is measured several times, a mean blank curve is determined from the
different measurements.

Input range 1-10
Default value 1

Blank value correction

on | off (Default value: off)

If the check box is activated, a blank peak is taken into account in the
result calculation.

In determinations with Blank value correction a potential blank peak at
the defined peak potential is subtracted from sample and standard addi-
tion peaks.

No. of replications

No. of additions

Number of replications (= total number of measurements) for each varia-
tion (sample, standard addition).

Input range 1-10
Default value 2

Number of standard additions.



4 Software operation

Input range 1-10
Default value 2
4.1.3 Method parameters — Voltammetric

Tab: Menu bar » File » New Method » Voltammetric

The Voltammetric tab of the Method parameters dialog window con-
tains parameters for preparation procedures and measuring mode. The
parameters displayed for the sweep depend on the measuring mode

selected.

Sequence of a measurement:

The following steps are successively executed in the method run.

= The stirrer is switched on.
= Cyclovoltammetric pretreatment (only if No. of cycles > 0)

Start potential is applied.

Sweep is carried out towards Vertex potential with the defined
Potential step and Sweep rate.

At the Vertex potential the sweep direction is reversed and the
sweep continued towards Start potential with the defined
Potential step and Sweep rate.

The sweep ends at Start potential.

The cycle Start potential — Vertex potential — Start poten-
tial is repeated in accordance with the No. of cycles.

= Potentiostatic pretreatment

Potential 1 is applied during Waiting time 1 (if Waiting time
1>05)

Potential 2 is applied during Waiting time 2 (if Waiting time
2>05)

The stirrer is switched off.

Start potential is applied.

The system is idle for the time defined under Equilibration
time.

= Sweep

Measurement is carried out from Start potential towards End
potential with the Potential step which defines the resolution
of the curve and the Sweep rate which defines the rate of
potential change and some additional parameters specific to the
measuring mode.

The curve resulting from the sweep is saved and evaluated.

15



4.1 Creating a new method

_fcnmraj ] Determination WIHID;;] Evaluation ]

Cyclovoltammetric pretreatment Measuring mode

Startpolantal () 02

Vertex polential (V) 0 1 |

Potential step (V) am Sweep

Swaep rate (Vis) 1 | Aute )

Mo. of cycies 5 ‘Stat potental (v} 02
End potential (V) o1

Potentiostatic pretreatment Potential step (V) 001

Potensial 1 (V) L Pulse ampitude (V) 002

Waing time 1 {3} o Freguency izl 8

Potensial 2 (V) 0

Wasing time 2 (5} o

Equilibration time (s) 5

Figure 4  «\Voltammetric» tab of «Method parameters» dialog window

Cyclovoltammetric pretreatment

Start potential (V)

Potential where the cyclic sweep starts. The end potential is always the
same as start potential.

Input range -4.095 - +4.095 V
Default value -0.2V

Vertex potential (V)
Potential where the sweep direction is reversed.

Input range -4.095 - +4.095 V
Default value -0.1V

Potential step (V)
Potential step for potential ramp.

Input range 0.001 -05 V
Default value 0.01 V

Sweep rate (V/s)
Rate of potential change used for the cyclic sweeps.

Input range 0.001 -500 V/s
Default value 1V/s

No. of cycles
Number of cyclic sweeps to be carried out.

Input range 0-100
Default value 5

16



4 Software operation

E NOTE

The following condition applies to the definition of Potential step and
Sweep rate:

0.001 s < Potential step / Sweep rate < 1.3 s.

Potentiostatic pretreatment

Potential 1 (V)

Potential that is applied to the working electrode during the Waiting
time 1. This potential can be used e.g. as cleaning potential for the elec-
trochemical cleaning of solid-state electrode surfaces that have been con-
taminated with reaction products of electrode redox processes.

Input range -4.095 - +4.095 V
Default value oV

Waiting time 1 (s)

Potential 2 (V)

Time during which the Potential 1 is applied to the working electrode.
With Waiting time 1 = 0 s Potential 1 is not applied.

Input range 0-1300s
Default value O0s

Potential that is applied to the working electrode during the Waiting
time 2. This potential can be used e.g. as deposition potential for the
electrochemical deposition in stripping voltammetry.

Input range -4.095 - +4.095 V
Default value oV

Waiting time 2 (s)

Time during which the Potential 2 is applied to the working electrode.
With Waiting time 2 = 0 s Potential 2 is not applied.

Input range 0-1300s
Default value O0s

Equilibration time (s)

Time before the sweep during which the stirrer is already switched off and
the start potential is applied to the electrode.

Input range 0-1300s
Default value 5s

17
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4.1 Creating a new method

Measuring mode

Sweep

Click over the text box and select the measuring mode. After the selec-
tion, the parameters displayed for the sweep change according to the
mode selected.

Selection Sqaure wave | Linear sweep | Differential
pulse
Default value Sgaure wave

The parameters displayed for the sweep change according to the measur-
ing mode selected, but some parameters are common for the three tech-
niques:

Common sweep parameters

Current measuring range

Start potential (V)

End potential (V)

Potential step (V)

Selection of the current measuring range of the potentiostat used for the
measurement. With the setting «Auto» the measuring range is automati-
cally selected at the beginning of each sweep.

Selection Auto | 10 mA | 21 mA | £100 pA | £10 pA | 1
MA | £100 nA | £10 nA | £1 nA
Default value Auto

Potential where the sweep starts.

Input range -4.095 - +4.095 V
Default value -0.2V

Potential where the sweep ends.

Input range -4.095 - +4.095 V
Default value 0.1V

Potential step for potential ramp.

Input range 0.001-05V
Default value 0.01V

Sweep parametes for Square wave
(see Chapter 11.3, page 62)



Pulse amplitude (V)

Frequency (Hz)

Sweep rate (V/s)

4 Software operation

E NOTE

Appears only if measuring mode Square wave is selected.

Amplitude of the rectangular potential pulse superimposed on the poten-
tial step first in sweep direction and then against sweep direction.

Input range 0.001-0.25V
Default value 0.02V

E NOTE

Appears only if measuring mode Square wave is selected.

Frequency of the superimposed potential pulses.

Input range 1-400 Hz
Default value 80 Hz

Sweep parametes for Linear sweep
(see Chapter 11.1, page 57)

E NOTE

Appears only if measuring mode Linear sweep is selected.

Applied sweep rate. The sweep rate defines the rate of potential change
during the sweep.

Input range 0.001 - 500 V/s
Default value 1V/s

Sweep parametes for Differential pulse
(see Chapter 11.2, page 59)

19



4.1 Creating a new method

Pulse amplitude (V)

H NOTE

Appears only if measuring mode Differential pulse is selected.

Pulse amplitude of the rectangular potential pulse superimposed on the
potential step. The pulse is always applied in sweep direction.

Input range 0.001 -0.25V
Default value 0.05V

Pulse time (s)

H NOTE

Appears only if measuring mode Differential pulse is selected.

Time interval during which the potential pulse is superimposed on the
potential step.

Input range 0.001-1.3s
Default value 0.04s

Sweep rate (V/s)

E NOTE

Appears only if measuring mode Differential pulse is selected.

Applied sweep rate. The sweep rate defines the rate of potential change
during the sweep.

ﬂ NOTE

The following conditions apply to the definition of Potential step,
Sweep rate and Pulse time:

0.001 s < Potential step / Sweep rate < 1.3 s

Pulse time < Potential step / Sweep rate - 0.0001 s



4.1.4

Data Processing

Smoothing

4 Software operation

Method parameters — Evaluation

Tab: Menu bar » File » New Method » Evaluation

The Evaluation tab of the Method parameters dialog window contains
parameters for data processing, peak evaluation, and concentration calcu-
lation.

j General ] Dietermination ?vmmmu: i—mj

Data processing

Mﬂh‘\’ 1 'ﬁ

Calitration method | Stangard acaion ™

Substances

sqnsuan _m Charact. | Toleranc.. | Min. widl. Maxﬂ‘z‘._lllll ma.. Basehn_e :BZWDOI. _Slallbas Endbas. | Resultu. |
ol ] 0.05 0.08 05 0.001 Unear [ vaL

Standard solutions |_As Remove |

Humaer of standard solutions 1 H

Substance | Unit Standard 1 | Standard2 | Standard 3 | Standard 4 |
[ mgl 1

Volumes

Standard 1(mL} | Standard 2(mL} | Standard 3 (mL} Standard 4 (mL) |
01

| oK | | cancel Erces

Figure 5  «Evaluation» tab of «Method parameters» dialog window

The measured values are smoothed. This is done by weighted moving
average method using the Savitzky/Golay algorithm. The number of points
for averaging depends on the smoothing factor selected. The applicable
smoothing factor heavily depends on the number of points in the data set.
The more points within the curve, the higher the smoothing factor can be
without modifying the curve too much.

Input range 1-20
Default value 1

Calibration method

Substances

Content determination using single or multiple addition of a standard sol-
ution. For more information on standard addition see Chapter 11.7.1,
page 68.

Selection Standard addition

The Substances table of the Evaluation tab contains parameters for the
definition and recognition of substances, for peak evaluation and results

21
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4.1 Creating a new method

Substance

Active

calculation. For more information on peak recognition (see Chapter 11.4,
page 65).

Name of the substance. A maximum of 4 substances can be defined.

Entry 9 characters
Default value -

on | off (Default value: on)

Activate or deactivate the evaluation of the substance.

Characteristic potential

Tolerance (V)

Min. width (V)

Max. width (V)

Potential for the assignment of a peak to a substance.

Input range -4.095 - +4.095 V
Default value oV

Tolerance of the characteristic potential for the assignment of a peak to a
substance.

Input range 0.001-1V
Default value 0.05 V

Minimum width to accept a signal as peak.

Input range 0.001 - Max. width V
Default value o5V

Maximum width to accept a signal as peak.

Input range Min. width - 1V
Default value o5V

Min. measured quantity (pA)

Baseline type

Minimum peak height to distinguish noise from a peak.

Input range 0.000001 - 99999 pA
Default value 0.001 pA

The evaluation of detected peaks is carried out using approximated base-
lines (see Chapter 11.6, page 67).
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Selection Linear | Exponential | Polynomial | Horizontal
start | Horizontal end
Default value Linear

Base points automatically (V)
on | off (Default value: on)

With the check box activated, the software automatically defines start and
endpoint of the baseline for each individual curve.

Start base point (V)

E NOTE

Only active if the option Base points automatically is deactivated,
and if the baseline type Horizontal end is not selected.

Defines the start potential of the baseline which is used for all curves.

Input range -4.095 - +4.095 V
Default value oV

End base point (V)

E NOTE

Only active if the option Base points automatically is deactivated,
and if the baseline type Horizontal start is not selected.

Defines the end potential of the baseline which is used for all curves.

Input range -4-+4V
Default value ov

Result unit
Final result unit.

E NOTE

The result unit depends on the unit of the standard solution. If the con-
centration of the standard solution is @ mass concentration, e.g. mg/L,
the result unit has to be a mass concentration as well, e.g. pg/L. If the
concentration of the standard solution is a molar concentration, e.g.
pmol/L, the result unit has to be a molar concentration as well, e.g.
nmol/L.
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4.1 Creating a new method

[Add]

[Remove]

Standard solutions

Selection g/L | mg/L | pg/L | ng/L | mg/mL | ug/mL | ng/
mL | pg/mL | mmol/mL | pmol/mL | nmol/mL |
pmol/mL | mol/L | mmol/L | pmol/L | nmol/L

Default value Hg/L

Adds a new substance.

Removes the selected substance.

The table of standard solutions contains the standard solutions defined for
the method with the corresponding concentrations for the substances.
The substance names are automatically displayed according to the sub-
stances defined in the Substances table. The number of editable stand-
ard solutions for each substance depends on the Number of standard
solutions selected in the spin box.

Number of standard solutions

Substance

Unit

Standard 1

The maximum number of standard solutions is related with the number of
substances. It is possible to have less, but not more standard solution than
substances. With one substance, only one standard solution can be
defined. With two substances, both can be in one standard solution but
also separated into two individual standard solutions.

Selection 112|314
Default value 1

Name of the substance. The name cannot be edited and is automatically
taken from the table Substances.

Concentration unit of the substance in the selected standard solution.

Selection g/L | mg/L | pg/L | ng/L | mg/mL | yg/mL | ng/
mL | pg/mL | mmol/mL | pmol/mL | nmol/mL |
pmol/mL | mol/L | mmol/L | pmol/L | nmol/L

Default value mg/L

Concentration value of the selected substance in the standard solution 1.
The concentration unit is specified in the column Unit of this table.
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Input range 0 -999 (Increment: 0.001)

Default value 0
In a new method, The default value for the first sub-
stance in Standard 1, is 1 instead of 0.

Standard 2
ﬂ NOTE
Only editable if at least 2 substances have been defined in the Sub-
stances table and the Number of standard solutions is 2.
Concentration value of the selected substance in the standard solution 2.
The concentration unit is specified in the column Unit of this table.
Input range 0 - 999 (Increment: 0.001)
Default value 0
Standard 3
Only editable if at least 3 substances have been defined in the Sub-
stances table and the Number of standard solutions is 3.
Concentration value of the selected substance in the standard solution 3.
The concentration unit is specified in the column Unit of this table.
Input range 0 - 999 (Increment: 0.001)
Default value 0
Standard 4

H

Only editable if at least 4 substances have been defined in the Sub-
stances table and the Number of standard solutions is 4.

Concentration value of the selected substance in the standard solution 3.
The concentration unit is specified in the column Unit of this table.

Input range 0-999 (Increment: 0.001)
Default value 0
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4.1 Creating a new method

H NOTE

It is not possible to have one substance in multiple standard solutions.
One substance can only be contained in one standard solution. For
standard solutions which do not contain the substance the concentra-
tion has to be set to 0.

Volumes
In the table Volumes, the volume to be added per standard addition is
defined for each standard solution. The number of editable volumes
depends on the Number of standard solutions selected in the spin box
of the Standard solutions table. For more information on standard
addition see Chapter 11.7.1, page 68.

Standard 1 (mL)
Addition volume for Standard 1.

Input range 0.01 - 999 mL (Increment: 0.001)
Default value 0.1 mL

Standard 2 (mL)
Addition volume for Standard 2.

Input range 0.01 - 999 mL (Increment: 0.001)
Default value 0.1 mL

Standard 3 (mL)
Addition volume for Standard 3.

Input range 0.01 - 999 mL (Increment: 0.001)
Default value 0.1 mL

Standard 4 (mL)
Addition volume for Standard 4.

Input range 0.01 - 999 mL (Increment: 0.001)
Default value 0.1 mL
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4.2 Loading and saving a file

Loading a method

1 Click on & or on Menu bar » File » Load method....

2 Select the desired method file *.detp in the Load file dialog win-
dow. If necessary, browse for the location of the method. Click on
[Open] to load the method.

The default directory for methods is %eUSERPROFILE%\Docu-
ments\Metrohm\Portable VA Analyzer\Method .

Example methods can be found in the folder %oUSERPROFILE%
\Documents\Metrohm\Portable VA Analyzer\Examples
\Methods.

3 To check or edit method parameters of the loaded method click on
J or Menu bar » Method > Edit method parameters....

n NOTE

Some method parameters, e.g. voltammetric parameters, cannot
be edited anymore once a determination was carried out with the
loaded method. If voltammetric parameters have to be adapted,
the method file has to be reloaded.

Saving a method

1 If a modified method should be saved under the same name, click on
Menu bar »> File » Save method. The existing method file will be
overwritten.

H NOTE

Example methods are read-only and cannot be overwritten. In this
case, use the function Save method as... and save the method
under a new name.
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4.2 Loading and saving a file

2 If a modified method should be saved under a new name, click on
Menu bar » File » Save method as....

3 In the Save method dialog window, select the folder where the
method should be saved, type in a file name and click on [Save].

Loading a determination

1 Click on ¥ or on Menu bar > File » Load determination....

2 Select the desired determination file *.det in the Load file dialog
window. If necessary, browse for the location of the determination.
Click on [Open] to load the determination.

The default directory for determinations is %USERPROFILE%
\Documents\Metrohm\Portable VA Analyzer\Determination.

Example determinations can be found in the folder %USERPROFILE
%\Documents\Metrohm\Portable VA Analyzer\Examples
\Determinations.

3 To check or edit determination parameters of the loaded determina-

tion click on = or Menu bar » Method > Edit method parame-
ters....

ﬂ NOTE

Some method parameters, e.g. voltammetric parameters, cannot
be edited in a determination file. Nonetheless the reevaluation of
peaks and recalculation of standard additions is still possible. For
more information on the reevaluation of a determination see
Chapter 4.4, page 31.

If the voltammetric parameters of the determination method
should be adapted for future measurements, the parameters have
to be saved first, using the function Save method as.... The new
method, containing all parameters of the determination method,
can then be loaded and edited.
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4 Software operation

Saving a determination

1

Running a

If a modified determination should be saved under the same name,
click on Menu bar > File » Save determination. The existing
determination file will be overwritten.

ﬂ NOTE

Automatically saved determinations and example determinations
are read-only. In these cases use the function Save determina-
tion as... and save the determination under a new name.

If a modified determination should be saved under a new name, click
on Menu bar > File » Save determination as....

In the Save determination dialog window, select the folder where
the determination should be saved, type in a file name and click on
[Save].

determination

Establish the connection between the instrument and the software.
Load the method.

Prepare the measuring solution and place it in the measuring stand.
Assemble the measuring stand so that electrode and stirrer are
immersed in the measuring solution.

Click on © or Menu bar » Devices > Start.

Adapt the information in the dialog window Determination infor-
mation if necessary. When all details are correct click on [OK].

If the option Measure blank is active in the method, a message is
displayed in the subwindow Messages, as soon as the addition of
sample is required.
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4.3 Running a determination

Add the specified volume of sample through one of the two pipet-
ting openings in the transparent ring and confirm the addition by
clicking into the subwindow Messages.

When the addition of standard solution is required a message is dis-
played in the subwindow Messages. Add the specified volume of
standard solution(s) through one of the two pipetting openings in
the transparent ring and confirm the addition by clicking into the
subwindow Messages.

= The subwindow Run shows the progress of the determination.

= The subwindow Live curve displays the currently measured vol-
tammogram.

= The subwindow Curves displays an overlay of already measured
voltammograms on the tab Curves. On the tab Substance
name, the calibration of the corresponding calibration curve can
be found.

= The subwindow Results displays the results of all substances
specified in the method on the tab Results. Evaluation details,
like peak heights and peak positions, can be found on the tab
Substance name.

When the determination has ended, the determination file and, if
thus defined in the method, a PDF file with the report is automati-
cally saved.

E NOTE

Directories for automatic saving of determinations and reports are
predefined and cannot be modified.

Determination files are saved in the directory %USERPROFILE%
\Documents\Metrohm\Portable VA Analyzer\Determina-
tion . The file name is automatically generated from date and time
of the determination start and the sample identifier. The format is
YYYYMMDD-hhmmss ‘Sample identifier'.det.

The PDF file with the report is saved in the directory %USERPRO-
FILE%\Documents\Metrohm\Portable VA Analyzer
\Report. The format is YYYYMMDD-hhmmss ‘Sample identi-
fier'.det_Report.pdf.
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H NOTE

Automatically saved determinations are read-only. Changes of a
reevaluated determination must be saved under a new name.

4.4 Reevaluating a determination

In this section short instructions can be found how to:

= Adapting the peak recognition (page 31)

= Changing the final result unit (page 32)

» Excluding a curve from the evaluation (page 32)

= Adapting the baseline parameters for all curves (page 33)
= Adapting the base points for an individual curve (page 33)
= Adapting the settings for the standard addition (page 34)
= Adapting the sample size (page 35)

E NOTE

Changes will not automatically be saved to the determination. To save
changes use the function Save determination or Save determina-
tion as... (page 29).

H

Some method parameters, e.g. voltammetric parameters, cannot be
edited in a determination file.

If the voltammetric parameters of the determination method should be
adapted for future measurements, the parameters have to be saved
first, using the function Save method as... (page 27). The new
method, containing all parameters of the determination method, can
then be loaded and edited.

Adapting the peak recognition

1 Click on ) or Menu bar » Method > Edit method parame-
ters....
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4.4 Reevaluating a determination

2

1

2

In the dialog window Method parameters, go to the tab Evalua-
tion. In the section Substances, change the settings for the peak
recognition, e.g. Characteristic potential or Tolerance as
required.

Close the dialog window Method parameters with [OK].

The determination will automatically be recalculated with the new
settings.

Changing the final result unit

Click on =) or Menu bar » Method »> Edit method parame-
ters....

In the dialog window Method parameters go to the tab Evalua-
tion. In the section Substances go to the column Result unit and
select a unit from the drop-down menu.

E NOTE

The Result unit depends on the unit of the standard solution. If
the concentration of the standard solution is a mass concentra-
tion, e.g. mg/L, also the result unit has to be a mass concentration,
e.g. ug/L. If the concentration of the standard solution is a molar
concentration, e.g. pmol/L, the result unit has to be a molar con-
centration too, e.g. nmol/L.

3 Close the dialog window Method parameters with [OK].

1

2

The determination will automatically be recalculated and displayed
with the new result unit.

Excluding a curve from the evaluation

On the workplace go to the subwindow Results and select the tab
with the name of the substance for which a curve should be exclu-
ded from the evaluation.

In the column Used deactivate the check box of the curve which
should be excluded from the evaluation.
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3 Click on &) or Menu bar » File » Reprocess to reprocess the eval-
uation and calculation without the excluded curve.

Adapting the baseline parameters for all curves

1 Click on ) or Menu bar » Method »> Edit method parame-
ters....

2 In the dialog window Method parameters go to the tab Evalua-
tion, section Substances.

To set manual base points, deactivate the check box Base points
automatically and type in values for Start base point and/or End
base point.

A different baseline type can be selected from the drop-down menu
Baseline type.

3 Close the dialog window Method parameters with [OK].

The determination will automatically be recalculated with the new
settings.

Adapting the base points for an individual curve

1 On the workplace, go to the subwindow Results and select the tab
with the name of the substance for which the base point(s) should
be adapted.

2 In the column Manual base points, activate the check box for the
curve for which the base point(s) should be adapted.

3 Type in the new values for the base points in the column Start base
point and/or End base point.

4 (Click on &) or Menu bar » File » Reprocess to reprocess the eval-
uation and calculation with the new settings for the base point(s).
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4.4 Reevaluating a determination

Adapting the settings for the standard addition

ﬂ NOTE

The number of additions cannot be adapted subsequently. However,
curves can be excluded from the evaluation as described above (see
"Excluding a curve from the evaluation”, page 32).

1 Click on 2 or Menu bar » Method > Edit method parame-
ters....

2 In the dialog window Method parameters, go to the tab Evalua-
tion.

3 To adapt the concentration of the standard solution go to the section
Standard solutions. Adapt concentration and/or concentration unit
of the substance in the standard solution as required.

E NOTE

A substance can only be contained in one standard solution. In
case of multiple standards, the concentration in the other standard
solution(s) has to be O.

E NOTE

The Unit of the standard solution is linked to the Result unit of
the final result of the substance. If the concentration of the stand-
ard solution is @ mass concentration, e.g. mg/L, also the result unit
has to be a mass concentration, e.g. pg/L. If the concentration of
the standard solution is a molar concentration, e.g. ymol/L, the
result unit has to be a molar concentration too, e.g. nmol/L.

4 To adapt the volume of the standard addition go to the section Vol-
umes and adapt the addition volume of the standard solution as
required.
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H NOTE

The addition volume has to be specified in mL (milliliter).

5 Close the dialog window Method parameters with [OK].

The determination will automatically be recalculated with the new
settings.

Adapting the sample size

1 Click on 2% or Menu bar » Method *> Edit method parame-
ters....

2 In the dialog window Method parameters go to the tab Determi-
nation.

3 In the section Sample and volume adapt the volume for Sample
volume and/or Total cell volume.

H NOTE

All volumes have to be in mL (milliliter).

The Total cell volume is the volume of all solutions at the start of
the determination. This includes sample volume and auxiliary solu-
tions such as additional water and electrolyte, but not volumes for
standard addition. The standard addition volume will automatically
be taken into account.

4 Close the dialog window Method parameters with [OK].

The determination will automatically be recalculated with the new
settings.
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4.5 Printing of result and method

4.5 Printing of result and method

Printing a determination result

1 Load the determination file for which the report should be printed, if
not already loaded in the software.

2 (lick on # or Menu bar > Reports > Create PDF ....

3 In the dialog window Create PDF report, select the Report ele-
ments which should be documented in the report. The following
report elements can be freely combined by selection via check box.

= Results
— General and determination information.
— Table with concentration result for all substances in the
determination.
= Evaluation
— Table with evaluation details, like peak potential and peak
height, for each substance and curve.
— Table with regression data for each substance.
= Curves
— Overlay of all voltammograms which are visible.
— Individual calibration curve for each substance.
= Method
— Method parameters
= Procedure
— Method sequence

Confirm your selection by clicking on [OK].

4 In the dialog window Save PDF file as, type in the file name under
which the report should be saved. If necessary, browse for a different
directory to save the report. Confirm the entries by clicking on
[Save].

The PDF file with the selected report elements will be created and
saved in the specified directory.

Printing a method

1 Load the method file for which the parameters should be printed, if
not already loaded in the software.



2

3

4 Software operation

Click on P2 or Menu bar » Reports » Create PDF ....

In the dialog window Create PDF report the following Report ele-
ments can be selected via check box.

= Method

— Method parameters
= Procedure

— Method sequence

Confirm your selection by clicking on [OK].

In the dialog window Save PDF file as type in the file name under
which the method report should be saved. If necessary, browse for a
different directory to save the report. Confirm the entries by clicking
on [Save].

The PDF file with the method parameters will be created and saved in
the specified directory.
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5.1 Live curve subwindow

5 Curves
During a measurement, a live curve can be observed in the Live curve
subwindow.
After the sweep is finished, the curve is displayed in the Curves sub-
window on the tab Curves. All curves belonging to a determination are
overlayed.
All curves displayed in the subwindow Curves are also listed in the sub-
window Graphics. In the subwindow Graphics, you can edit the color
and visibility of the curves.
If a peak can be evaluated, the corresponding calibration point is dis-
played in the subwindow Curves on the tab ‘substance name’ calibra-
tion.

5.1 Live curve subwindow

The subwindow Live curve (7-6) is only visible, if an instrument is con-
nected to the computer. It shows the currently measured voltammogram.

File Devices View Cunves Method Repoits Language Help

BWd X 000 TA® & C v

Run = 0| cunes = Results -F0
1.0
09
03
T 07
=
; Zoe
Stir 10.0 sec £
[
[42 Measuresample | 5
g 04
03
02 Add standard
02
Stir 10.0 sec 0.1
0.0
0/2 Measure standard 00 01 02 03 04 05 08 0F 08 08 10
Potential (V)
Results | As(ll)
Graphics o
v 52 Graphics
0.65 ¥ ol 19460010
0.60 ¥ [ Live curve
\ W SWv_0006_sample_rep _01
0.55 [ Determination
0.50 [ File graphics
< 045 \
Messages = -
g #8 = 00
5 \
£ 035
S
O 030
0.25
0.20
015 —
R
0.10
030 025 020 015 040 005 000 005 0.0 015 020 025
Potential (V)
— SWV_0006_sample_rep 01
Connected 19460010 |Running  |node 1 |Measuring [Time: 2.8 5, Potentiat: 0.250 v, Current: 6.126 uA

Figure 6  Live curve subwindow



5 Curves

During a measurement, all voltammetric sweeps, including the cyclovol-
tammetric pretreatment sweeps, are displayed in the subwindow Live
curve.

After the sweeps are finished, the curves are copied to the tab Curves of
the subwindow Curves, except for the pretreatment curves. Pretreatment
curves are not copied, since they are neither evaluated nor saved.

In the Default workplace and Mosaic workplace layout the Live
curve is displayed in a separate subwindow. In the Tabs workplace lay-
out the Live curve appears as a tab in the Curves subwindow.

Curves subwindow

This subwindow includes maximum 6 tabs, depending on the workspace
layout selected.

In the Default workplace layout, the subwindow Curves has up to 5
tabs:

= The tab Curves shows all voltammograms belonging to the determina-
tion.

= The tab 'Substance 1' calibration shows calibration curve of sub-
stance 1.

= The tab 'Substance 2' calibration shows calibration curve of sub-
stance 2, if substance 2 is used.

= The tab 'Substance 3' calibration shows calibration curve of sub-
stance 3, if substance 3 is used.

= The tab 'Substance 4' calibration shows calibration curve of sub-
stance 4, if substance 4 is used.

In the Tabs workplace layout, the subwindow Curves has up to 6 tabs:

= The tab Curves shows all voltammograms belonging to the determina-
tion.

= The tab 'Substance 1' calibration shows calibration curve of sub-
stance 1.

= The tab 'Substance 2' calibration shows calibration curve of sub-
stance 2, if substance 2 is used.

= The tab 'Substance 3' calibration shows calibration curve of sub-
stance 3, if substance 3 is used.

= The tab 'Substance 4' calibration shows calibration curve of sub-
stance 4, if substance 4 is used.

= The tab Live curve shows the currently measured voltammogram.

In the Tabs workplace layout, the curves are shown in a larger window,
because the other tabs are hidden behind the current tab.

In the Mosaic workplace layout, each curve, voltammogram or calibra-
tion curve, is displayed in a separate subwindow.
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5.2 Curves subwindow
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Figure 7 Curve subwindow: mosaic-based view

You can change the size of each window and drag and drop it in the
desired position.

Options for manipulating the curve

With the options in the View menu, you can change the general appear-
ance of the Curves subwindows, such as scaling, labels, and background
color. You can also print the curve or save it as a *.PNG file.

With the options in the Curves menu or the context menu of the sub-
window Graphics you can do the following:

= Change the name and the color of the curve.

= Select visibility options.

» Export data of the selected curve to a *.csv file

= Copy data of the selected curve to the clipboard
= Export all the curves to a *.csv file.
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Displaying a 3D plot of a curve

5 Curves

1 Click on View » 3D plot.

The Curves selection dialog window opens.

SWV_042_sample_rep 01

SWV_048_sample_rep _02

SWV_054_addition _01_rep 01

SWV_060_addition _01_rep _02

SWV_066_addition _02_rep 01

SWV_072_addition _02_rep _02

Figure 8  Select curves window for 3D plot

2 =

[Ctri]+click or [shift]+click actions to select multiple curves.

= Click on [OK]

The 3D settings and curve values dialog window opens.

Select the curves to be included in the 3D plot. Use standard

*
Mode : [Represent curves as a surface |'] Mode : [Represent curves individualy |']
Line width |2 ¥ Line width |2 | ¥
Name Value Name | value
SWV_042_sample_rep ... 0 SWV_042_sample_rep ...
SW\V_054_addition _01... 1 SW\V_054_addition _01...
SW\V_066_addition _02... SW\V_066_addition _02...
@ Cancel

Figure 9 3D settings window options

Represent curves individually
= If Represent curves individually is selected, define the Line

width.

Select the Mode of the 3D plot: Represent as a surface or
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5.3 Displaying a 3D plot of a curve

= Define the sequence of the selected curves by changing the num-
bers in the Value column.

Figure 10 3D plots

Options for manipulating the plot

= To rotate: Left click and drag mouse
= To scale: Roll mouse wheel

= To Z Shift: Right click and drag mouse
= To animate: Double left click

= To stop animation: Left click

u_n

» To save as .png: click “s” on the keyboard



6 Results

The subwindow Results contains two different types of tabs:

Results

6 Results

Shows the final result and the corresponding regression data used for

the calculation. The information is summarized for all substances

defined in the method.

Results

As(total)

Concentration = 4.368 pg/L
ASD =0.154 pg/L

RSD =353 %

Function: y = 9.494e-02*x +
Coefficient R-squared =0.9

3.437e-07
9713

Results | As{total)

‘Substance name’
1 to 4 tabs showing evaluation details, like peak position and peak
height of each individual curve. For each substance defined in the
method an individual tab with the corresponding evaluation details in a

table is available.

Results

Used | Curve | Potent... | Height... | Startb... | End b... | Manu...
W SWv_0... -0.002 0.3480.. -0.086 0.130 L
W SWv_0.. -0.000 0.3420.. -0.092 0.137 L
W SWv_0.. 0.001 0.6010... -0.095 0.144 L
W SWV_0... 0.002 0.5889... -0.093 0.140 L
W SWV_0... 0.005 0.8530.. -0.094 0167 L
[ SWV_0... 0.006 0.8820.. -0.094 0185 L

As(total)
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6.1 Results tab

During a determination, the evaluation details are continuously updated.
The results are refreshed as soon as another sweep is finished.

6.1 Results tab

Concentration

ASD

RSD

Function

Coefficient R-squared

The Results tab shows the concentration and regression data for 1 to 4
substances, depending on the number of substances defined in the
method. Concentration(s) and regression data are displayed as soon as a
sufficient number of calibration points is available for the calculation. The
results are automatically refreshed after each sweep.

For details on the calculation of the linear regression using Least Square
Fit method see Chapter 11.8.1, page 72.

For details on the calculation of the concentration from the regression
data using standard addition technique see Chapter 11.7.2, page 69.

The following parameters are displayed for each substance:

Substance concentration in the sample with respect to the Sample vol-
ume defined in the method.

Absolute standard deviation of the substance concentration in the sample.

Relative standard deviation of the substance concentration in the sample.

Result of the calculation of the linear regression of the standard addition
curve, with offset in [A] (Ampere) and slope in [A/(g-L-1)].

Coefficient R2 of determination calculated from the calibration function.



6 Results

6.2 Evaluation details

Used

Height (pA)

Potential (V)

Start base point (V)

End base point (V)

Manual base points

Each sweep is tested for the presence of peaks which can be correlated to
a substance defined in the method (for details on the automatic peak rec-
ognition, see Chapter 11.4, page 65).

If a peak is detected, the peak height is evaluated using an approximated
baseline (for details see Chapters Peak height, page 66 and Baseline
type, page 67). The details of this evaluation, such as peak position, peak
height and baseline parameters are listed in a table for each substance on
an individual tab, tagged with the substance name. In this table, it is also
possible to adapt the evaluation of individual curves, either adapting base
points or excluding the curve from evaluation.

The following evaluation details can be found in the table:

on | off (Default value: on)

If the check box is activated, the curve is used for the result calculation.
Individual curves can be excluded from result calculation.

The peak height with the fixed unit pA.

For the evaluation of the peak height, a perpendicular is dropped from the
peak maximum to the baseline and the height between peak maximum
and baseline is determined.

The peak potential with the fixed unit V.

For the evaluation of the peak position, the potential value corresponding
with the maximum current value of the peak is determined.

The potential value of the Start base point of the baseline in Volt.

The potential value of the End base point of the baseline in Volt.

on | off (Default value: off)

If the check box is deactivated, the base points are automatically set
according to method settings.
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6.2 Evaluation details

If the check box is activated, a manual value for each the start point and
end point can be entered.

The manual values are highlighted in red until the determination is reproc-

essed using (< or File » Reprocess the curve evaluation. After the
reprocessing, the start base point and end base point for the baseline of
this peak are forced to these manual values and the red cells will be dis-
played in the normal color.

Results

Used | Curve | Potent. |Height.. | Startb.. | Endb.. | Manu.. |

: 0. -0.002 0.3480... 4 3
) Swvo0. 0000 03420 -0092 0137 [
) swvo. 0001 06010. -0.095 0144 [
) SswWvo0. 0002 05389 -0093 0140 [
& [Fooesoaer Y V)
W U

SWv_0.. 0.005 0.8530...
SWv_0.. 0.006 0.8820.. -0.094 0185

Asftotal)

For more details on reevaluating a determination see Chapter 4.4, page
37.



7 Procedure editor

7 Procedure editor

Dialog window Method » Advanced settings > Procedure editor

The Portable VA Analyzer software allows configuring and programming
advanced command sequences that can be mixed with the actual proce-
dure. Open the Procedure editor to program or configure individual

sequences.

Commands

GUI message
Wait

Stir

Stir onfoff
FPurge

Purge onfoff
Digital output 2

Down

Modify

Figure 11 Procedure editor

Commands

Commands available for adding to a procedure.

GUI message

Procedure

Properties

Stir

Loop begin
Measure blank
Loop end

Add sample

Stir

Loop begin
Measure sample
Loop end

Loop begin

Add standard
Stir

Loop begin
Measure standard
Loop end

Loop end

Substance: As{lll)
Concentration: 0.5 mgiL
WVolume: 0.1 mL
Substance: As{lll)
Concentration: 0.5 mgiL
WVolume: 0.1 mL

The text of the message will be displayed in the Messages subwindow
on the workplace according to its position in the command sequence.

Wait

Waiting time (s).

Stir
Stirrer action.

In the Properties box, a stirring rate must be selected and a stirring time

(s) defined.

Stirring rate

Only available if the command Stir is selected.

Input range

500 - 4000 1/min
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Stirring time

Stir on/off

Purge

Purge time

Purge on/off

Digital output 2

Procedure

Properties

[>>]

Only available if the command Stir is selected.

Stirring time in seconds.

Stirrer action. Switches the stirrer on or off unless another command says
otherwise.

Purging action (s). The digital output 1 of the DIO cable (not included) is
set to a high level (3.3V) for the time defined in the command, in order to
control an external purge valve (not included).

In the Properties box, a purging time must be selected.

Only available if the command Purge is selected.

Purging time in seconds.

Purging action. Sets the digital output 1 of the DIO cable to a high level
(3.3V) if on or to a low level (0 V) if off, in order to control an external
purge valve (not included).

Sets the digital output 2 of the DIO cable (not included) to a high level
(3.3V) if on or to a low level (0 V) if off, in order to control an external
device.

Commands originating from the method or determination loaded are dis-
played in gray and cannot be modified.

Commands added from the Commands box are shown in black and can
be modified.

Properties of the command selected in the Procedure box.

Moves the command selected in the Commands box to the Procedure
box. The command is entered at the top of the list. A dialog window
appears reminding the user to enter the properties of the command.



[<<]

[Up]

[Down]

[Modify]

[Exit]

7 Procedure editor

Moves the command selected in the Procedure box to the Commands
box.

Moves the command selected in the Procedure box up one position in
the list.

Moves the command selected in the Procedure box down one position
in the list.

Opens the dialog window of the command selected in the Procedure
box to modify the properties.

E NOTE

Only commands inserter from the Procedure editor can be modified.
All gray commands have to be edited in the Method parameters dia-
log window of the workplace.

Closes the Procedure editor dialog. The modified procedure is shown in
the Run subwindow.

Editing a procedure

1 Select a command from the Commands box.

2 To move the command to the Procedure box, click on [>>].

The command is entered at the top of the list.

3 To move the command to the appropriate position in the list, click on
[Down].

4 To modify the properties of the command, click on [Modify].

5 Once the procedure is edited, click on [Exit].

The modified procedure is displayed in the Run subwindow. The
modified method can be saved and executed like a normal method.
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E NOTE

Standard method parameters can be edited in the Method
parameters dialog window (see Chapter 4.1, page 9).

Commands introduced via Procedure editor can only be edited
in the Procedure editor.



8 Other options

8 Other options

8.1 Check battery level

Dialog window: Tool bar » Devices > View battery level

The internal battery level of the instrument can be checked any time
except if a determination is running.

Battery level X

@ Battery level: 100%

If the battery level is lower than 30 %, we recommend to charge the bat-
tery using the power adapter.

8.2 Service option

The Service option is only available to authorized staff with a password.

8.3 Device info

Dialog window: Menu bar » Help » Device info

The Device Info dialog window shows the following information about
the instrument connected:

= Device type
= Firmware version
= Serial number
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8.4 Change language

8.4 Change language

1 = Inthe menu bar, click on Language.
= Select English or Chinese.

2 To apply the new language, close the software and restart it.

8.5 Help

To open the PDF file of the software manual, in the menu bar click on
Help » Manual.

To show the name and version of the software, in the menu bar click
Help » About....

About Portable VA Analyzer X

Portable VA Analyzer
Version 1.0




9 Firmware update

9 Firmware update

The firmware of the instrument can be updated with the *.hex files provi-
ded.

Updating the firmware

1 = Connect the 946 Portable VA Analyzer to the computer using the
USB cable provided.
= Switch on the potentiostat

2 On the computer, start the Portable VA Analyzer Firmware
uploader. Click on Start » All programms » Metrohm » Porta-
ble VA Analyzer » Portable VA Analyzer Firmware uploader.

* | Portable VA Analyzer ... EX]
Help

| Explore... |

File (.hex):

Serial port:

A Program

Firmware Uploader 1.1

3 Click on [Explore...] and navigate to the location of the *.hex file.

4 Select the Serial port to which the instrument is connected. Find
more information on the serial port in chapter "Manual driver instal-
lation" in the Software installation manual (8.946.8002EN).

5 Click on [Program]. Wait until the update is finished successfully.

ﬂ NOTE

The update can take several minutes. Do not disconnect the 946
Portable VA Analyzer instrument while update is in progress.

When the update is finished:

= The firmware uploader software shows the message Firmware
uploaded in the footer.
= On the potentiostat the green and yellow status LEDs light up.
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6 On the potentiostat, press the Reset button.

The upload is completed. The 946 Portable VA Analyzer is ready to
be used with the uploaded firmware.



10 Troubleshooting

10 Troubleshooting

Problem Cause Remedy
Error - Connection The USB cable is not con- = Disconnect the software from the instru-
error nected. ment.

Connect the USB cable between potentio-
stat and PC/laptop.

Restart the Software and re-establish the
connection (see "Connecting the instru-
ment after a connection error”, page 8)

The potentiostat is
switched off.

Disconnect the software from the instru-
ment.

Switch on the potentiostat and check for
the green status LED which indicates that
the power is on.

Restart the Software and re-establish the
connection (see "Connecting the instru-
ment after a connection error”, page 8)

The connect button is
clicked too shortly after
switching on the instru-
ment.

Disconnect the software from the instru-
ment.

After the potentiostat is switched on it
takes a few seconds before the USB com-
munication is established. Allow 5 s and
retry to connect the potentiostat.

Restart the Software and re-establish the
connection (see "Connecting the instru-
ment after a connection error”, page 8)

Error - No device The USB cable is not con-
available nected.

Connect the USB cable between potentio-
stat and PC/laptop.

Connect the instrument manually (see
"Connecting the instrument manually",
page 7)

The potentiostat is
switched off.

Switch on the potentiostat and check for
the green status LED which indicates that
the power is on.

Connect the instrument manually (see
"Connecting the instrument manually",
page 7)
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10.1

Problem

Cause

Remedy

The connect button is
clicked too shortly after
switching on the instru-
ment.

After the potentiostat is switched on it
takes a few seconds before the USB com-
munication is established. Allow 5 s and
retry to connect the potentiostat.
Connect the instrument manually (see
"Connecting the instrument manually”,
page 7)

Error - Potentiosat
not found

The USB cable is not con-
nected.

Connect the USB cable between potentio-
stat and PC/laptop.

Connect the instrument manually (see
"Connecting the instrument manually”,
page 7)

The potentiostat is
switched off.

Switch on the potentiostat and check for
the green status LED which indicates that
the power is on.

Connect the instrument manually (see
"Connecting the instrument manually”,
page 7)

The connect button is
clicked too shortly after
switching on the instru-
ment.

After the potentiostat is switched on it
takes a few seconds before the USB com-
munication is established. Allow 5 s and
retry to connect the potentiostat.
Connect the instrument manually (see
“"Connecting the instrument manually”,
page 7)
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11 Appendix

11.1

11.11

Linear sweep measuring mode

Principle

Linear sweep measuring mode is the classic, simplest voltammetric meas-
urement mode. The potential applied to the working electrode is continu-
ously changed with the rate defined by the parameters potential step and
potential step time, resulting in a potential ramp with the slope of the
sweep rate. For each step the resulting current is measured and plotted as
a function of the potential U of the potential step. On a static electrode
this results in a peak-shaped curve, in accordance with the Cotrell equa-
tion:

i Current

(1) = nFA~ND - Co . o
AT -1 n Number of electrones

exchanged in the electro-
chemical reaction

F Faraday constant
9.648 - 10* A-s/mol

Electrode area
Diffusion coefficient
Cq Concentration of analyte

T Pi (3.14159...)
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11.1 Linear sweep measuring mode

U t(i) t(i) t(i) u Potential

t Time

Usiare | Start potential

0 Usep | Potential step
tstep Potential step time
- - ——— i Measuring time (Current
’ t(i) measurementat the end of
t the potential step)
i
i Current

Ineak | Peak height

peak

/_-—-—-——/l Upeax | Peak potential
i
|

Sequence of individual steps

In the Linear sweep measuring mode, the following individual steps are
successively executed in the method run:

Linear sweep measuring mode

1 Stirrer on
The stirrer is switched on with the defined Stirring rate.

2 Stirring time
Idle until the period defined in the Stirring time parameter has
expired.

3 Cyclovoltammetric pretreatment

= The Start potential is applied.

= The sweep is carried out towards Vertex potential with the
defined Potential step and Sweep rate.

= At the Vertex potential the sweep direction is reversed and the
sweep is continued towards Start potential with the defined
Potential step and Sweep rate.



11.2

11.2.1

11 Appendix

= The sweep ends at Start potential.
» The cycle Start potential - Vertex potential - Start potential
is repeated in accordance with the No. of cycles.

4 Potentiostatic pretreatment

= Potential 1 is applied to the electrodes during Waiting time 1
(if Waiting time 1> 0 s).

» Potential 2 is applied to the electrodes during Waiting time 2
(if Waiting time 2 > 0 s).

5 Stirrer off
The stirrer is switched off.

6 Start potential

The Start potential defined in the sweep is applied to the electro-
des.

7 Equilibration time

Idle until the period defined in the Equilibration time parameter
has expired.

8 Sweep

= The measurement is carried out from Start potential towards
End potential with the Potential step defining the resolution
of the curve and the Sweep rate defining the rate of potential
change.

= The curve resulting from the sweep is stored and evaluated.

Differential pulse measuring mode

Principle

In the differential pulse measuring mode, a gradually increasing potential
ramp (as in linear sweep voltammetry) is overlaid with rectangular pulses
which are applied in sweep direction. The current j is measured immedi-
ately before the pulse and at the end of the pulse. The difference between
the two measured currents is plotted as a function of the potential U of
the potential step. This results in a peak-shaped curve.

Differential pulse measuring mode is the most universal and frequently
used voltammetric measurement mode. It is equally well suited for irrever-
sible and reversible systems and offers a high sensitivity.
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11.2 Differential pulse measuring mode

U Potential
v W ) ) ) t | Time
Usare | Start potential (see page
18)
Upuse | Pulse amplitude (see
...... page 20)
Tl Uy, Usep | Potential step (see page
18)
Liep touse | Pulse time (see page 20)
........ e tw, | Potential step time
: Measuring time (Current
t(i;) measurement immediately
i before pulse start)
Measuring time (Current
t(i5) measurement immediately
before pulse end)
ipeak
i Current
Ineak | Peak height
U u i=1i,— | Difference between the
peck i two current measurements
Upeac | Peak potential

Sequence of individual steps

In the Differential pulse measuring mode, the following individual steps

are successively executed in the method run:

Differential pulse measuring mode

1 Stirrer on

The stirrer is switched on with the defined Stirring rate.

2 Stirring time

Idle until the period defined in the Stirring time parameter has

expired.
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Cyclovoltammetric pretreatment

= The Start potential is applied.

» The sweep is carried out towards Vertex potential with the
defined Potential step and Sweep rate.

= At the Vertex potential the sweep direction is reversed and the
sweep is continued towards Start potential with the defined
Potential step and Sweep rate.

= The sweep ends at Start potential.

» The cycle Start potential - Vertex potential - Start potential
is repeated in accordance with the No. of cycles.

Potentiostatic pretreatment

= Potential 1 is applied to the electrodes during Waiting time 1
(if Waiting time 1 >0 s).

= Potential 2 is applied to the electrodes during Waiting time 2
(if Waiting time 2 > 0 s).

Stirrer off
The stirrer is switched off.

Start potential

The Start potential defined in the sweep is applied to the electro-
des.

Equilibration time

Idle until the period defined in the Equilibration time parameter
has expired.

Sweep

= The measurement is carried out from Start potential towards
End potential with the Potential step defining the resolution
of the curve and the Sweep rate defining the rate of potential
change. The parameters Pulse amplitude and Pulse time
define the superimposed rectangular pulse.

= The curve resulting from the sweep is stored and evaluated.
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11.3 Square wave measuring mode

11.3

11.3.1

Square

Principle

wave measuring mode

In the square-wave measuring mode (according to Osteryoung), a gradu-
ally increasing potential ramp (as in linear sweep voltammetry) is overlaid
with rectangular AC potentials with a constant amplitude. For each poten-
tial step a rectangular pulse is applied in sweep direction and another one
contrary to the sweep direction. The current / is measured at the end of
each pulse during the measuring time. The difference between the two
measured currents is plotted as a function of the potential U of the poten-
tial step. This results in a peak-shaped curve.

Square-wave measuring mode is primarily suitable for reversible electrode
processes. It is used particularly for sensitive stripping voltammetric deter-
minations.
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U Potential
i) ()t (i)
t Time
Usare | Start potential (see page
16)
U, . i Ugmpr | Amplitude
""" Lol Usep | Potential step (see page
R 18)
ZLstep =
1/f
Potential step time
f=Fre-
quency
; : Measuring time (current
"""" ’ by = 11 i) measurement at the end
t ' of the pulse in sweep
direction)
Measuring time (current
i) measurement at the end
2| of the pulse contrary to
sweep direction )
i eal
o i Current
Ineak Peak height
i=i; — | Difference between the
U i two current measurements
U
peak
Upeax | Peak potential

Sequence of individual steps

In the Square wave measuring mode, the following individual steps are
successively executed in the method run:

Square wave measuring mode

1 Stirrer on
The stirrer is switched on with the defined Stirring rate.

2 Stirring time
Idle until the period defined in the Stirring time parameter has
expired.
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11.3 Square wave measuring mode

Cyclovoltammetric pretreatment

= The Start potential is applied.

= The sweep is carried out towards Vertex potential with the
defined Potential step and Sweep rate.

= At the Vertex potential the sweep direction is reversed and the
sweep is continued towards Start potential with the defined
Potential step and Sweep rate.

= The sweep ends at Start potential.

= The cycle Start potential - Vertex potential - Start potential
is repeated in accordance with the No. of cycles.

Potentiostatic pretreatment

= Potential 1 is applied to the electrodes during Waiting time 1
(if Waiting time 1 >0 s).

= Potential 2 is applied to the electrodes during Waiting time 2
(if Waiting time 2 >0 s).

Stirrer off
The stirrer is switched off.

Start potential

The Start potential defined in the sweep is applied to the electro-
des.

Equilibration time

Idle until the period defined in the Equilibration time parameter
has expired.

Sweep

= The measurement is carried out from Start potential towards
End potential with the Potential step defining the resolution
of the curve and the Sweep rate (given by Sweep rate =
Potential step - Frequency) defining the rate of potential
change. The parameters Pulse amplitude and Frequency
define the superimposed rectangular pulse.

= The curve resulting from the sweep is stored and evaluated.



1.4

Peak recognition

11 Appendix

The derived curve is used to search for consecutive minima U,,;, and max-
ima U, A maximum followed by a minimum indicates a normal peak, a
minimum followed by a maximum a "reversed peak". These values are
used to determine the peak potential U,.q and the peak width W for each
peak. After peak detection, a baseline is constructed and the peak height
H is determined from the value of the peak maximum minus the value of
the baseline at the position of the peak potential.

w

m— 1

Wmin

i = Current

U = Potential

A

di/dU = 1st derivative of the current
with respect to the potential

W = Peak width = | U, - Uppay /

W ,in = Minimum peak width = Min.
width

di/dU

Umax

Uver e Utol

Umin

W nax = Maximum peak width =
Max. width

H = Peak height

Hpin = Minimum peak height = Min.
measured quantity

U.., = Characteristic potential

U,,; = Tolerance of the characteristic
potential

Unmax = Maximum potential of the
derivative

Upeak

Upmin = Minimum potential of the
derivative

Upeax = Peak potential = (Upqy +
Umin) /2

The detected peaks are assigned to the defined substances based on these
estimated values and the parameters defined on the Recognition tab in
the Substances section. In the process, the following tests are carried

out:

= Peak potential
Upeak = Uyer £ Uy
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11.5

11.5 Peak height

= Peak width
W > Wi
W < Wppax

» Peak height
H > Hpin

This peak is assigned to the corresponding substance and thus recognized
as substance peak when all test conditions are fulfilled. The peak is labeled
with the substance name in the curve display if Show substance label is
enabled in the menu View.

Peak height

The software can automatically evaluate a peak in a measurement curve.
Using the peak height, the software can also perform an automatic cali-
bration.

For the evaluation of the Peak height, a perpendicular is dropped from
the peak maximum to the baseline and the height between peak maxi-

mum and baseline is determined. The peak height is output as current i
[Al.

i = Current

U = Potential

S = Start base point

E = End base point

B = Baseline

A = Peak area

H = Peak height
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11.6 Baseline type

The evaluation of detected peaks is carried out using approximated base-
lines.

The following types of baselines are differentiated:

Baseline type Description

A Linear

Linear baseline between two auto-
matically determined or manually
specified base points.

A Horizontal start

y Horizontal baseline starting from the
automatically determined or man-
ually specified start base point.

The evaluation of the first peak half
is used for asymmetric peaks.

Horizontal end

Horizontal baseline starting from the
automatically determined or man-
ually specified end base point.

The evaluation of the second peak
half is used for asymmetric peaks.

\ 4
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11.7 Evaluation - Calibration

Baseline type Description

A Exponential

y Curved baseline for peaks that are
located in the ascending or descend-
ing part of another peak or of the
background current. The base points
can be determined automatically or
specified manually.

4 Polynomial

y Curved baseline for peaks that are
located in a valley between two
ascending curve parts. The base
points can be determined automati-
cally or specified manually.

Legend:

S = Start base point
E = End base point
H = Peak height

11.7 Evaluation - Calibration

11.71 Rules for the standard addition

Standard addition is the usual calibration method for voltammetric deter-
minations. Its advantage is the high accuracy, as the calibration in the
sample takes place under real matrix conditions and all measuring param-
eters remain unchanged. The following rules should be followed to ensure
optimum trueness and minimized scattering:

» Check linearity range
The linearity range should be checked for each substance when devel-
oping a method. To do so, spike the substance several times over a big
concentration range. From the calibration curve displayed in the
Curves subwindow, tab 'Substance name' you can determine in
which range the standard addition is linear and in which it is nonlinear.
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= Spiking procedure
If the substance content is in the linear range, then repeated spiking
only makes sense if you want to check the linearity during each deter-
mination. In order to minimize scattering, it is better to spike only once
but select the highest possible number of replications.

= Spiking ratio 1:1 to 1:5
The optimum spiking ratio for the entire spiking procedure is 1:1 to
1:5, i.e., the sum of all spiking amounts should be one to five times the
sample amount present in the measuring vessel.

= Keep spiking volume low
Every spiking dilutes the measuring solution and thereby reduces the
sample signal. The software corrects the resulting error. Nevertheless,
the volumes used for the standard addition should be as small as possi-
ble. At the end of the determination the volume of all added standard
solutions should not be more than 10% of the total volume.
50 to 200 pL standard solution are usually added per spiking for 10 mL
of measuring solution.

= Evaluation quantity has to be monotonously ascending
A regression is only calculated for the standard addition if the evalua-
tion quantity Peak height gets bigger with each spiking (monoto-
nously ascending). If the evaluation quantity gets smaller with each
spiking (monotonously descending) or the function is not monotonous,
.e. the peak gets bigger after one spiking and smaller after another, no
regression and no result will be calculated.

11.7.2 Calculation of the standard addition

With the standard addition procedure (also known as spiking technique), a
known amount of the substance(s) to be determined is added to the sam-
ple once or more. This addition is carried out manually. The following pro-
cedure is used to calculate the substance concentration in the measuring
vessel CONCM:

1 Measurement of the sample solution

The sample solution with the unknown substance concentration
CONCM is measured once or more (defined by the number of repli-
cations y). This results in:

= the evaluation quantity Peak height y (shown on the workplace
in the subwindow Results on the tab with the evaluation details
(tagged with the substance name) and in the PDF report in the
column Height (pA) under Evaluation details)

= the mean value of all replications of the evaluation quantity y for
the sample (shown only in the PDF report in the column Mean
height (pA) under Evaluation details)
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11.7 Evaluation - Calibration

= the absolute standard deviation of all replications of the evalua-
tion quantity y for the sample (shown only in the PDF report in the
column Std deviation (pA) under Evaluation details)

2 Measurement of the spiked sample solutions

The sample solution is spiked n times with a standard solution with a
known substance concentration. Each of these spiked solutions is
measured once or more (defined by the number of replications y).
This results in:

= the evaluation quantity y(n) of a single measurement for the
spiked sample n (shown on the workplace in the subwindow
Results on the tab with the evaluation details (tagged with the
substance name) and in the PDF report in the column Height
(MA) under Evaluation details)

= the mean value of all replications of the evaluation quantity y(n)
for the spiked sample n (shown only in the PDF report in the col-
umn Mean height (pA) under Evaluation details)

= the absolute standard deviation of all replications of the evalua-
tion quantity y(n) for the spiked samples (shown only in the PDF
report in the column Std deviation (uA) under Evaluation
details)

= the difference x(n) between the substance concentration c(n) in
the spiked sample n and the substance concentration CONCM in
the original sample solution

Calculation of the standard addition curve

For the calculation of the linear standard addition curve, the parame-
ters CALCO and CALC1 of the following linear regression curve are
determined by weighted least squares:

y(n) = CALCO + CALC1 - x(n)
with y(n) = Peak height
and x(n) = c(n) — CONCM

The calibration function y = CALC1- x + CALCO is displayed in the
Results subwindow on the tab Results. The coefficients have the
following meaning:

= CALCO =y axis intercept of the standard addition curve
= CALC1 = slope of the standard addition curve

Calculation of the substance concentration CONCM

A prerequisite for the application of the standard addition is that for
¢ =0, the evaluation quantity y is also = 0. If 0 is entered in the cali-
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bration function for these two quantities, the substance concentra-
tion CONCM can be calculated using the following equation:
CALCO
CALC1

CONCM =

In the graphical display of the standard addition curve, the substance
concentration CONCM is set by the distance from the point of origin
to the intersection point with the regression line.

I CALCO

y = Peak height

Ay X =c - CONCM

Ax

Ay / Ax = CALC1 = slope

CALCO =y axis intercept

\ 4

CONCM

>

x=c-CONCM

CONCM = the unknown substance con-
centration

M =sample

® = spiking

Calculation of the total error of the concentration calculation
of CONCM

The total error CONCM.ASD of the result CONCM is determined
with a linear error calculation. Irrespective of the number of measure-
ments, the total error is always calculated so that CONCM =+
CONCM.ASD indicates the area in which the true value of CONCM
may be expected with a probability of 68.3%.

Calculation of the substance concentration in the sample
CONC

Taking the dilution of the sample by the added auxiliary solutions into

account, the substance concentration in the sample is calculated as
follows:

cone - CONCM -V,

SAMPLE

Variable Description

CONC Substance concentration in the sample.

CONCM Substance concentration in the measuring vessel.
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11.8 Evaluation - Calculated results

Variable Description

Vior Total volume in the measuring vessel at the moment
of the sample measurement.

VsanpLe Sample volume.

11.8 Evaluation - Calculated results

11.8.1 Result calculation from calibration curves and error calculation

The concentration (e.g. @ mass concentration or a molar concentration) in
the measuring vessel must be determined with the help of a calibration
curve. This calibration curve itself must be determined by the measure-
ment of solutions for which the concentrations are known. The parame-
ters for a specified linear or nonlinear curve function are then calculated
from the value pairs Evaluation quantity / Concentration. Because, as
a general principle, the calculations of the calibration curves and the
results based on them as well as the associated error calculation remain
the same for all calibration methods, the calculation procedure that is
applied is described in general terms below.

The connection between the variables x and y are sought on the basis of
the measured values x;, y;, for which it is assumed that the following pre-
requisites apply:

= The variable x is error-
free. 4
= The variable y is y
dependent on x and
can be described by the
function y = y(x). Yi
= The error with the Vi
measurement of y is
distributed normally
and is sufficiently small
to be able to apply lin-
ear error calculation.

Function y=y (x)

»
L ]
+ Measured values
o Estimated values

-

*
X

X

Depending on the calibration method selected, the following model func-
tions are available for the calculation of the calibration curve y = y(x):

Selected curve type | Calibration func- | Description
tion
Linear regression y=a+bx Line

To calculate the parameters a and b, the Least Squares Fit method is
applied, for which the sum of the squared deviations of the measured val-
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ues y; from the estimates y; is minimized. The scatter g,; of the measured
values is usually not constant, however, but rather dependent on their val-
ues. Therefore, the deviations can be weighted with the factor g;.
Extremely scattered values should be given less weight, more precisely
measured values should be given more weight. It is known from statistics
that, under the conditions listed, weighting 1/variance = 1/standard devia-
tion? = 1/<oy,i)2 yields the best results. In practice, however, the number of
repeated measurements is too low to allow estimates from the measured
values o to be made. A general fact is of help here:

In the case of most measuring instruments, the scatter is comprised of a
constant basic part and of a part proportional to the measured quantity.
Influences that change over time also exist, however, e.g. the electrode
status or the temperature. These usually change only slowly, which is why
they can be regarded as constant during the measurement. One can
therefore take their influence into account by means of an (unknown) fac-
tor p, which is multiplied against the basic scatter. Because of the fact that
a constant factor has no influence over curve fitting, however, it can be
ignored.

n with
Zgi (v, — )2 = Minimum 1 1

i

g = =
=t (‘{m‘)z (» ‘70;)2

The weighting must adopt a constant value for small measured values in
the vicinity of the instrument noise in order to exclude the possibility that
small measured values are over-weighted.

The weighting is also appropriate if a calibration curve is acquired across a
wide concentration range. Without weighting, the wide scatter of the val-
ues with a high concentration would falsify the calibration curve for the
small values.

The calculated calibration curve is used with subsequent measurements to
determine the associated result x,, from the mean value y,. The mean
value yy, and the scattering g, of the individual values are defined
thereby as follows:

1< m ()2
?M =E Zyml. g JM:\/ZFI(.}M{ J”Irf)

m—1

The estimation of the total error g, of the result x, is carried out with a
linear error calculation that takes into account not only the error
amount from the measurement but also that from the calibration. Because
of the fact that the two amounts are statistically independent of one
another, it is not the individual errors o that are added but rather their var-
iances a2 (with t = Student factor):
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(0.)*=t [(‘&M)z + (Jx,C)E]

The error amount from the measurement itself is calculated from the
derivative of the calibration function resolved in accordance with x in
accordance with y and the measured scattering g, as follows:

A\’

(0" = (5;) (o)

The errors of the individual parameters p; = a, b of the calibration function
used are determining for the calculation of the error amount from the cali-
bration. Because of the fact that these parameters are statistically depend-
ent on one another, all covariances cov(p;, p) must be taken into account
here:

dx Ox c )
o COV (P, Dy
= ap; apj !

(‘Tx,t?)g =

Statistically speaking, only small random samples (<10) are determined for
voltammetric measurements from a population with Gaussian distribution.
These random samples indicate a Student distribution that is taken into
account with the Student factor t. If the variance is made up of a number
of partial variances, then the Student factor is calculated by means of
Welch-Satterthwaite formula approximation. The variance acquired with
this procedure is multiplied by t?; the resulting square root yields the
standard deviation of the result.

The Student factor t depends on the number of measurements n, or, to be
more precise, on the number of degrees of freedom n — f, for which n is
the number of measuring points and f is the number of estimated parame-
ters. The Student factor t is defined as follows for a probability of 68.3%:

n-f t n-f t Curve type f

1.321

7 1.077 20 1.026 | y=a+ bx 2

Even though probabilities of 90% and more are usual in statistics, we
select 68.3% in order to ensure compatibility with the conventional speci-
fication of normally distributed measured values Mean value * Standard
deviation. With normally distributed values, a standard deviation corre-
sponds to a probability of 68.3%.

The total error CONCM.ASD of the result CONCM consequently indi-
cates the CONCM £ CONCM.ASD area in which the true value of
CONCM may be expected with a probability of 68.3%.
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11.8.2 Curve results

11.8.2.1 Substance name

Description

Substance name

Decimal places

Unit

11.8.2.2 Peak

potential of a substance

Description Peak potential
Decimal places 3
Unit \Y
11.8.23 Height
Description Peak height
Decimal places 6
Unit HA
11.8.2.4 Mean value of the heights of all replications
Description Mean value of the peak heights of all replications.
Decimal places 6
Unit HA

11.8.2.5 Absolute standard deviation of the heights of
all replications

Description Mean value of the peak heights of all replications.
Decimal places 6
Unit HA

11.8.2.6 Delta of the mean values of the heights of all
replications

Description

tions for the variation {x-1}.

Difference between the mean value of the peak heights of all replications
for the variation {x} and the mean value of the peak heights of all replica-

Decimal places

6

Unit

HA
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11.8.2.7 Start base point of baseline
Description Start base point, where the peak evaluation baseline begins.
Decimal places 3
Unit \'
11.8.2.8 End base point of baseline
Description End base point, where the peak evaluation baseline ends.
Decimal places 3
Unit \'
11.8.3 Calibration curve results
Standard results of the calibration curve calculation are referred to as cali-
bration curve results. They are created once per substance.
The results of the regression (CALCO and CALC1 and R2) are calculated
as soon as a sufficient number of calibration points of different concentra-
tions is available for the selected calibration curve type. The variables will
be recalculated once again and their old value will be overwritten as soon
as another calibration point is added.
11.8.3.1 Coefficient CALC O
Description Zero-order coefficient of the standard addition curve.
Decimal places 3
Unit A
11.8.3.2 Coefficient CALC 1
Description First-order coefficient of the standard addition curve.
Decimal places 3
Unit Concentration unit of the standard | A-L-g™
solution = #g/L
Concentration unit of the standard | A - L - mol™
solution = #mol/L
11.8.3.3 Coefficient of determination R?
Description Coefficient of determination R2.

Decimal places

5

Unit
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Calculation

iz::(yi _y)z _,Z:‘(yi _JA’i)Z

2 _ =
R n

z (yi - y)2
i=1

Variable Description

R? Coefficient of determination.

Yi y value of calibration point /.

y Mean value of all y values of the calibration points.

j;l. The y value of calibration point /i calculated with the cali-
bration curve.

11.8.4 Concentration results

11.8.4.1 Substance concentration in the sample
Description Substance concentration in the sample.
Decimal places 3
Unit Unit of standard solution
Sample volume #g/L #mol/L
mL #a/lL #mol/L
Calculation
CONC = CONCM V,or
SAMPLE
Variable Description
CONC Substance concentration in the sample.
CONCM Substance concentration in the measuring vessel.
Vior Total volume in the measuring vessel at the moment of
the sample measurement.
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Variable Description
Voanpie Sample volume.
11.8.4.2 Absolute standard deviation of the concentra-

tion of the substance in the sample

Description

Absolute standard deviation of the substance concentration in the sam-
ple.

Decimal places

3

Unit same as for substance concentration in the sample (see Chapter 11.8.4.1,
page 77)
11.8.4.3 Relative standard deviation of the concentra-

tion of the substance in the sample

Description

Relative standard deviation of the substance concentration in the sample.

Decimal places

2

Unit

%
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